


Cover designed by Lee Won-tak

May 2011

Get in my belly

Funz

Tales

Off you go

Get outta’ dodge

Ahh..that’s how it works

Useful information

p5 - SeoraeGalmagi
p51 - Restaurant Guide

p21 - How-to-Daegu : Photoshop 
p25 - Hagwon to EPIK

p39 - Samsung Lions Schedule
p51 - Restaurant Guide
p53 - Hotel Guide

p7 - Ultimate Frisbee
p12 - Eco Biking
p15 - DSR Festival Schedule
p20 - Disc Golf
p46 - Daegu Bowling League

p29 - Subway Map
p31 - Downtown Daegu Map
p33 - Kyungpook Uni. Map
p34 - Suseong-gu Map
 

p17 - Provincial Report : Pohang
p48 - Event Calendar
p57 - Event Reviews

p36 - Trans-Siberian Railroad pt. 2
p41 - 2011 IAAF Update
p43 - 4Play (Music Review)
p55 - Buddha’s BDAY
p59 - Get your Jazz on!



Editor’s Notes

Hi Daegu,

This is the second edition of the Daegu Compass.  We hope you 
enjoyed the first one.  Each month we plan on expanding, grow-
ing and shaping the Compass to be the best source of information 
for Daegu residents.  

We would like to note that we forgot to add Jimi Cusick to the 
first edition’s credits.  Sorry, Jimi, won’t happen again.

We would like to thank all our sponsors and readers for support-
ing the Compass.  If you would like to contribute, sponsor or have 
suggestions on how to improve the Compass, we’ld love to hear 
from you.  Please email me: yuri@daegucompass.com  

Thanks, 

Lee Yu-ri and the Daegu Compass team

The Daegu Compass wants to be the best source of information for visitors and 
foreigners living in Daegu.

In order for that to happen, we need your help.  Although we have lived in Daegu 
for many years, we know that each person’s experience in Daegu is different.  We 
would like to help share your experiences with others living in and visiting this 
unique city.

Get started by joining our team of volunteer writers, photographers, translators and 
promoters as we gear up for something special, something different, something new.

The Daegu Compass will help make your stay in Daegu a memorable one.  
Gift certificates, discounts on events, travel opportunities, and more are available for 
those who sign up.

Email us at: volunteers@daegucompass.com to start getting involved in your 
community. 

We feel the Compass is on the right track, but with your help it can be GREAT!  

Thanks Daegu, for gett’n it done!

The Daegu Compass team

The Daegu Compass is published and printed by Spark Media.  
The views expressed by the writers in the Daegu Compass do not reflect the opinions of the company.  
Maps, the Daegu Compass logo, and original designs are all property of Spark Media.  
If you have any questions, please email: info@daegucompass.com.  Thanks for reading.
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Hotels

Novotel
Inter-burgo Exco
Inter-burgo Manchon
Daegu Grand Hotel
+more coming soon

Downtown

Thursday Party
Greeks Kebabs
Holy Grill 
Traveler’s Bar & Grill
Mies (both locations)
Gogo Vinyl 
Who’s Bob
Bennigans
Maldives Fitness Club
+More

Around Daegu

Camp Walker
Camp Henry
Camp Carroll
Hami Mami’s 
Hagwons
Universities
Public Schools
+More

Daegu is very spread out.  We need your help with 
distribution.  Email us at: info@daegucompass.com to 
find out how you can help.  Thanks folks!

Distribution

Join the team today!  

Compass
All-Stars 

Pohang

Tilt Bar and Grill

Busan

All Thursday Party bars

DISTRIBUTION AND CREDITS JOIN OUR TEAM

downtown
+ new Sang-in location

Baek San, Park Mina, 
Jean, Ha Mi-yong

Sales & PR

Lee Won-tak, 
FUSION

Lee Yu-ri

 Ha Mi-yong

3 4



RESTAURANT REVIEW RESTAURANT REVIEW

SeoraeGalmaegi Downtown’s Newest Korean BBQ

If you’ve spent much time 
in Daegu, or any South 
Korean city for that matter, 

then chances are you are familiar 
with barbecue restaurants. They’re 
everywhere. While there are 
differences between any two busi-
nesses, those differences tend to 

be subtle, and overall there seems 
to be a standard formula followed 
by all; ultra-casual, small menus, 
no frills atmosphere. That’s not 
a bad thing. After all, Korean 
barbecue is delicious and fun. 
The simplicity of seeing choice 
cuts of meat grilled over an open 
flame right before your eyes is 
always cool. Add to that the joy 
of picking from large assortments 
of vegetables and condiments to 
enhance each bite, the incredible 
variety that you can have within a 
single meal…What’s not to love?
 
Still, after becoming somewhat ac-
customed to the standard formula 
mentioned above, it was a great 
pleasure (and a welcome change 
of pace) to step into SeoraeGal-

maegi in downtown Daegu. First 
of all, the décor and atmosphere 
is far from “no frills.” You enter 
through sliding glass doors and 
onto a spacious platform which 
stands above the dining area. This 
platform actually serves a practical 
purpose because the place gets 

packed, so a big open space to 
hang out while you wait for a table 
is convenient. Walk down a small 
flight of stairs and you are in the 
center of a bustling environment. 
The large staff of employees is 
constantly in motion. The best 
way to de-
scribe them 
might be a 
“team.” The 
preparation 
area in back 
is visible 
through a 
large win-
dow. Take 
a seat at a 
dark wood 
table which 
matches the 

hardwood floors and notice just 
how nice a place it is. Despite the 
fact that it’s crowded and the staff 
numbers at least 20 there is no 
cramped feeling. They’ve maxi-
mized the space so that no table is 
unpleasantly close to another,thus 
you never get the sense that you’re 
eating with strangers. The dining 
room isn’t huge by any stretch 
of the imagination and yet it 
feels wide open.The dim lighting 
is relaxing as opposed to the 
sometimes maddening fluorescent 
bulbs which illuminate so many 
places like this. Often, barbecue 
restaurants have a kind of dingy 
look and feel, and sometimes that 
can be part of their charm, but 
SeoraeGalmaegi is immaculate 
and nicely put together. It’s just 
comfortable.

Even though every one of them is 
busy, the staff is very friendly, so 
if you have any questions do not 
hesitate to ask. My table ordered 
boneless, marinated pork. That 
is pretty standard fare at any 
barbecue place but SeoraeGalmagi 
sets itself apart with the unbeliev-
able quality of the dish. As soon as 

it arrived at the table we knew we 
were in for a treat. The nice por-
tion of marbled pork sat glistening 
in its marinade. We began to grill it 
up post haste and eagerly watched 
it turn brown and then just slightly 
charred. Each of us doctored 

our pieces with kimchi, dipping 
sauces, onions, garlic, etc. and bit 
in. The pork was tender, juicy, and 
incredibly flavorful. Something 
about the marinade was different 
than any other I’ve had. Let me 
also stress just how tender it was. 
It was almost as though we weren’t 

eating meat, but some buttery 
substance which tasted like meat. 
I initially had some reservations 
because there were no lettuce 
leaves among all of our sides and 
condiments and I love to use 
them to wrap each bite. However 

I forgot about it almost right away. 
At any rate it’s not like there was a 
shortage of things on the table to 
enrich every mouthful. I may have 
been able to ask a waiter for some 
leaves, but again, once we started 
eating I stopped thinking about it. 
There is even more good news 

about SeoraeGalmagi: They 
have five locations in Daegu! In 
addition to the one downtown 
they also have restaurants in 
Kyeongbookuni, Gyemyeonguni 
(Seongseo), Duryu and Sangin. 
So if downtown is a little out of 
your way, or you’ve spent enough 
wild party nights there for one 
lifetime (I know the feeling) then 
you should try to check out one of 
their other sites. If you choose to 
go to the downtown spot it’s right 
in the heart of things: between 
KUSH and Who’s Bob. The fact 
that they have multiple locations 
in a city saturated with barbecue 
joints is a testament to how good 
they are. SeoraeGalmagi is truly a 
cut above.

The menu offers a little more variety 
than most barbecue restaurants in 
Daegu, but it is not overwhelming. 
The amiable staff can help you with 
it if you have any trouble. The prices 
are more than fair. Orders which can 
feed two people range from 12,000 
Won to 19,000. Beers cost 3,000. Two 
people can easily have a good sized 
meal and drinks for under 30,000. It’s a 
good bargain at a nice place with great 
food…Can’t beat that.

Two people can easily have a good sized meal and 
drinks for under 30,000. It’s a good bargain at a 
nice place with great food…Can’t beat that.

Written by Lee Flory and photograghed by Ivan Broida

한국어 요약문 페이지 19쪽에
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Ultimate Frisbee goes 
NATIONAL

Republic of  Korea Ultimate (ROK-U) 

www.rokultimate.com
Republic of Korea Ultimate (ROK-U), formerly called the Daegu 
Ultimate Frisbee League, has expanded too much beyond the bor-
ders of Daegu to be marketed as simply a Daegu team-based league 
anymore!  This great social rec league has gained popularity over 
its first 4 seasons, to the point where 12 teams, from 4 cities across 
the nation now will partake in the Fall 2011 season.  There will be 
7 teams in Daegu, 3 in Busan, 1 in Daejeon and 1 in Gyeongju!  

Fall 2011 League play kicks off in early September 2011 and runs 
to the first week or two of November.  However, with so many 
logistics of balancing schedules, city and team play, rosters, drafts 
and team clothing orders, April is when registration has opened!  
Limited spots are only available, but it should be noted that this 
league is not for the elite Ultimate player.  The league caters to all 
skill levels, all ages, and of course, all nationalities.  This summer, 
there will be an extra marketing emphasis to seeing more Koreans 
involved in the game.  Not only is this a great league to meet new 
friends, form relationships, get in shape, or just come out to drink 
a beer on a weekend’s afternoon – it’s a lso a great way to practice 
your English and Korean on and off the field.  Call it a sporty 
language exchange if you will.  

Registration is easy to do:  Simply go to www.rokultimate.com and 
click on the sidebar tab labeled “Fall League 2011 Registration”  

All the information about dates and locations 
will be listed on the actual online registration 
form itself.  But, for those interested and have 
read this article up to this sentence, the league 
consists of 14 regular season games – includ-
ing 2 out of town affairs.  A one-day visit to 
historical Gyeongju (about a 20 minute KTX 
ride from Daegu) and a weekend tournament 
in Busan.  One day on the beach.  Saturday on 
Haeundae Beach and Sunday on a beautiful turf 
field. 
 
All teams make the playoffs – meaning, if you 
are a beginner or an expert, you can choose 
to play the season how you and/or your team 
wants you to!  You can use the 14 games as a 
practice setting for learning your newly-ac-
quired Ultimate skills, or you can use it to build 
up your stats and try to break some ROK-U re-
cords.  Statistics are kept, and not just goals and 
assists – if you go to the website, you’ll notice 
some extra-ordinary stats, that might make you 
compete a little bit harder for that extra point, if 
that is your thing.   If you don’t care about learn-
ing the game, or about acquiring stats, never 
fear, the coolers will be stocked full of beer 
and the banter will be in full swing along the 
sidelines.  It’s a great chance to talk with some 
of the other foreigners in the city, meet others 
from around the country, and mix and mingle 
with some of the veterans and rookies to the 
game.  You might even forget you are involved 
in a game, as sometimes the beers can go down 
more quickly than you’d like.
  
So, again, simply register yourself on the web-
site, pay your league fee (60,000W) which will 
cover all your games, your team jersey, your sta-
tistics, your equipment… the list goes on.  Well 

Daegu 
Storm

Daegu 
Tsunami

Daegu 
Pollution

Daegu 
Pollution

Daegu 
Lightning

Daegu 
Hurricane

Daejeon 
Pandemic

Busan 
Heat

GyeongJu 
Godzilla

ULTIMATE FRISBEE

SIGN UP
NOW

VIST 
THE
WEBSITE

ULTIMATE FRISBEE

Written and photographed by 
Marty Nedjelski
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worth it for over 2 months of solid fun.    A 
great excuse to get outside, and even on 
some weekends, get outside the city! 
 
If you are new to the league, you will be 
entered into a draft, where captains will 
select you based on your needs – maybe 
you have a friend that you want to play 
with… no problem, again, just mention 
that on your online registration form, and 
we’ll see what we can do for you.

Again, this league will cater to (hopefully) 
all your needs – or at least we will try our 
best to make you happy! 

ULTIMATE FRISBEE

If you have any questions, concerns or inquiries, 
please look-up one of the following resources:

Website:  http://www.rokultimate.com

Email: daegufrisbee@hotmail.com

           Republic of Korea Ultimate

Your League Organizer is:  Marty Nedjelski

“Hope to see you all on the field in September!”
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Have you ever been sitting at a 
Daegu bus stop, watching the 
ticker and wondering why the bus 
you’re waiting for doesn’t seem to 
be getting any closer, when all of a 
sudden a pack of shiny spandex-
clad cyclists races by? Hundreds 
of men, women, and children 
riding bikes of all different types 
and sizes, from giant unicycles to 
low-riding, stylized tricycles, from 
million-won designer models to 
that rusty one that has been lying 
on its side next to KNU’s North 
Gate for at least three months 
now. What are they all doing?

Welcome to the Daegu Bike 
Festival. Funded by Daegu City 
Hall and organized by the Daegu 
Council for Local Agenda 21 
(맑고푸른대구21추진현의회), 
the DBF is an opportunity for cy-
clists of all shapes and sizes, ages, 
races, and levels of ability and ded-
ication to enjoy themselves while 
at the same time demonstrating 
that Daegu is indeed a bikeable 
city. From humble beginnings in 
2006, the DBF has grown into 
an event that regularly attracts 
hundreds of riders, and sometimes 
more – over one thousand people 
participated in last October’s 
event, the Daegu Bike Rally, a 
leisurely 25 kilometer course from 
Daegu World Cup Stadium to the 
main gate of Keimyung Univer-
isty. (Actually, all the way to the 
cafeteria. Followed by free lunch.) 
Other rides last year included a 
scenic ride along the Nakdong 
River in May and a loop from 
downtown to Dusan intersec-
tion and back to celebrate Daegu 

Car-Free day in September. Every 
ride begins with signing in and 
picking up your raffle ticket and 
ends with dozens of gifts, ranging 
from the small (helmets) to the 
big (bicycles) to the just plain 
strange (environmentally-friendly 
frying pans).

The DBF represents more than 
just a chance to win some free 

stuff, though. For the chronically 
lost, the process of finding the 
starting location, following the 
course, and making your way back 
home from the destination is an 
excellent way to learn the layout 
of the city, while the chronically 
bored may encounter restaurants 
and shops that would otherwise 
have gone unknown. If thoughts 
of giant carbon footprints weigh 

Daegu Bike FestivalECO BIKING
ECO BIKING ECO BIKING

Written, translated and photographed by Mike Roy
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heavy on your conscience, DBF events 
may be a chance to get started doing some 
good. If you’re interested in bicycles, bike 
fashion, or bike-mounted gizmos, you’ll 
have plenty to feast your eyes on. For those 
looking to meet other bicycle enthusiasts 
to arrange rides with, there’s no better 
place to be. If you like to feel important, 
you can ride at the front of the pack, right 
next to the police escorts. And if you’ve 
been waiting for an opportunity to parade 
around in public wearing spandex, well...
you aren’t alone.

DBF kicked off its 2011 campaign in 
March with over one thousand partici-
pants taking a 14-kilometer trip around 
West Daegu, while the April ride brought 
participants from downtown to Suseong-
gu and back. Events are scheduled every 
month through November – for more 
details about dates and courses, 
visit http://www.ecobike.org.

DBF events are always free of charge and 
always open to one and all. So far, few 
foreigners have heard about or participated 
regularly in the festivities. This year, let’s 
ride together in order to raise awareness, 
while at the same time helping to make a 
cleaner, healthier, more friendly Daegu. 

ECO BIKING ECO BIKING

대구 버스정류장에 앉아서 
전기 간판을 바라보며 당신이 기다
리는 버스가 왜 오지 않는지 궁금
해 할 때, 갑자기 반짝이는 스판덱
스를 입은 수백 명의 사이클리스트
들이 순식간에 지나가는 것을 본 
적이 있나요? 남녀노소 할 것 없
이, 다양한 사람을이 다양한 자전
거 – 커다란 외발 자전거에서 누워
서 타는 세발 자전거까지, 백만원
을 호가하는 명품 자전거에서 경
대 북문에 3개월 이상 망치되어 누
워 있는 녹슨 저전거까지 – 를 타
고 다닌다. 신기하지요? 그들은 무
엇을 하고 있을까요?

대구 자전거 대행진 (DBF)에 온 
것을 환영합니다. 대구 시청의 재
정 지원을 받아 맑고푸른대구21추
진협의회가 진행하는 자전거대행진
은, 체격과 나이, 인종과 실력, 참
여 경혐과 상관없이 많은 사람들이 
즐거운 시간을 보낼 수 있다. 동시
에 대구가 저전거로 쉽게 다닐 수 
있는 도시임을 입중할 수 있는 좋
은 기회이다.

2006년에 시작된DBF의 처음은 미
약했지만, 계속해서 많은 사람들이 
참여하면서 이제는 수백 명의 사람
들이 참여하는 행사가 되었다. 작
년 10월의 대구 자전거 랠리 (대구 
월드컵경기장에서 성서계대정문까
지 25km코스를 편안히 따라간)에
는 천명 이상이 참여했다. (사실, 
계대 안 식당까지 갔지요. 밥을 공
짜로 먹기도 했고.) 작년 행사에는 
5월의 낙동강을 따라 간 코스와 9
월 “대구 차가 없는 날”을 경축
하기를 위한 시내에서 두산오거리 
일주를 거치오는 코스가 있었다. 
모든 행사는 접수하고 경품권을 받
는 것으로 시작되며, 수십 개의 경
품 작은 것 (헬멧)과 큰 것 (자전
거), 이상한 것도 (친환경 후라이
팬) 을 선물하는 것으로 끝난다.

하지만DBF는경품을 얻는 기회만 
있는 것은 아니다. 길치에게는, 출
발지를 찾고 코스를 따르고 집에 
다시 돌아 가는 길을 찾는 과정에

서 우리의 대구광역시의 모습을 배
울 수 있을 것이다. 또한, 만성적
으로 심심한 사람들은 알 수 없었
던 식당과 가게를 맞닥뜨릴지도 모
른다. 자동차가 뿜어내는 오염에 
대해서 많이 고민하는 사람들에게
는, DBF는 좋은 일을 시작할 기회
가 될 수도 있다. 만약에 자전거와 
저전거 패션, 그리고 최신 자전거 
악세서리에 관심이 있다면, 구경할 
것들이 많을 것이다. 자전거를 좋
아하는 친구를 찾는다면, 이보다 
더 좋은 곳이 없을 것이다. 주목받
고 싶다면 경찰 호위대 바로 옆에 
타면 되고요. 마지막으로는, 스판

덱스를 입고 잘난 척할 핑계를 찾
는다면, 이곳으로 오세요. 당신이 
혼자가 아니다.

2011년 첫번째 행사에는 3월에 진
행되었고 약 1000명이 같이 서대구

에서 14km코스를 따라 갔으며, 4
월의 행사의 참석자들은 시내부터 
수성구까지 갔다 왔다. 11월까지 
매월 행사가 있다. 자세한 날짜나 
코스에 대한 정보를 찾고 싶거나 
앞으로 진행될 행사에 신청하려면, 
http://www.ecobike.org 에 접속
하면 된다.

DBF은 늘 무료로 진행되고 누구
나 참여할 수 있다. 지금까지는 대
구 자전거 대행진에 대해 잘 알고 
정지적으로 참여하는 외국인이 매
우 적었다. 올해는 저전거를 같이 
타는 것을 통해서 사람들의 인식을 

높이는 동시에 더 깨끗하고, 건강
하고, 사랑스러운 대구를 만들도록 
노력합시다. 

다른 친환경 식당, 가게ㅘ 행사를 더 알고 싶다면 http://noksaeksari.blogspot.com 방문하거나 페이스북에서 녹

색살이대구 / Daegu Green Living 이라는 그룹을 찾아 보는 것이 도움이 될 것이다. 매월 시내 Buy the Book에

서 상영될 친환경 영화 관람에 누구든지 환영합니다. 

If you're interested in finding out about eco-friendly restaurants, 
shops, and events in Daegu: 

 please visit http://noksaeksari.blogspot.com  

 find the group 녹색살이대구 

 Daegu Green Living on 

Feel free to stop by one of our monthly Eco-film nights, held 
downtown at Buy the Book.
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Dongseongro 
Festival 2011

DSR Scavenger hunt
3rd Annual

FREE : Sign up

May 22 @ 2pm

http://dsr.or.kr/

email: events@daegucompass.com Daegu Dongseongro Festival 2011

WIN prizes
WIN prizes

WIN prizes
WIN prizes

Dongseongro 
Festival 2011

Teams of 4 people will race to compete for prizes 
(1st, 2nd, and 3rd places) earning points for completing as many 
tasks as possible during 2 hours,  using photographs and objects 
as evidence. 

The HUNT will Start at 2pm SHARP in front of the main stage 
near Burger King!  You're racing for prizes sponsored by TCN, 
Novotel, Bennigans, Gyeongsan FUN FUN Beach and Hite.

DONGSEONGRO FESTIVAL 2011 DSR 2011

DSR SCHEDULE
This schedule highilghts the events we think you’ll be most 
interested in.  Please visit the DSR website 
www.dsr.or.kr for more information or email us at 
events@daegucompass.com

5.19 (Thu)  
19:00 

DSR Opening 
event

5.20 (Fri) 
14:00 ~14:50 

Bennigan’s 
event {Game 
and coupon 
event}

5.20 (Fri)  
17:00~17:50

Opening show 
@ Downtown’s 
Main Stage

5.20 (Fri) 
18:00~18:50

MOTTO EL fash-
ion show

5.20 (Fri) 
20:00~21:30

D-Concert 20th

5.21 (Sat) 
16:00~16:50

HITE Beer drink-
ing 
contest

5.21 (Sat) 
20:00~21:30

Maldive Cool 
and Sexy body 
contest

5.22 (Sun) 
14:00~18:00

Scavenger 
hunt : teams of 
4 compete for 
prizes

5.22 (Sun) 
5:00~15:50/ 
17:00~17:50

Musical Gala 
show

5.22 (Sun) 
16:00~16:50

HITE Beer drink-
ing 
contest

5.22 (Sun) 
19:00~20:00

Donseongro 
music 
contest

winning!

er...yogi

Photos by Scott McLaughlin

Photo by Grahm Zeiba

Photo by Luke Roper’s team
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Tilt Bar n Grill’s move to 
Bukbu beach might be the greatest 
thing to happen to Pohangers 
since Burger King opened at the 
POSTECH student union.  The 
new location is only 300m from 
the beach and out door seating.  

Inside Tilt’s ample seating includes 
a raised “VIP” lounge situated 
above a beanbag hooka lounge.  
Four large screen TVs over-look 
a new wooden bar that serves a 
wide selection of beers and mixed 

drinks.  Beers on Tap include Al-
ley Cat and Heineken at the lowest 
prices in Pohang. The prices get 
even better during the daily 7-9pm 
happy hour. 

On any given night patrons can 
try their hand at darts.  Beer pong, 
possible Pohang’s signature sport, 
is held every weekend.  An Xbox 
and a Nintendo Wii are hooked 
up and the owner assures us that 
plans for a Guitar Hero tourna-
ment are in the works.  On Sunday 
afternoons board games and card 
games have become a regular 
fixture.

Tilt serves bar food standards like 
Cheesy Fries and Buffalo Wings 
everyday, but it is Burrito Wednes-
days and Fish ‘n Chips Fridays that 

Pohangers look forward to every 
week.  Tilt is also there for you 
and your hangover with breakfast 
every Sunday afternoon.  A Break-
fast Platter and stiff Bloody Mary 
is sure to cure what ails you.  

Not too shabby considering the 
humble beginnings of a Bar and 
Grill that was first opened in a 
former Papa Rotti.  Seating was 
limited to only four tables in the 
old location of Tilt, or “Mini-Tilt” 
as the locals lovingly refer to it.  

However, 
somehow 
Pohangers 
were able 
to squeeze 
dozens and 
dozens of 
birthday 
parties, 
costume 
parties, 
welcome 
parties, 
goodbye 
parties, holi-
day parties, 
and possibly 
even one Bar Mitzvah into a space 
that was the same size as most 
English teachers apartments.

The new space, with room to 
drink, dance, and play games and 
Tilt’s proximity to Bukbu Beach 
are making the prospect of sum-
mer in Pohang look better and bet-
ter. “Pohangers” love their beach 
with its wide selection of grilled 
clam restaurants and surreal view 
of POSCO Steel Company’s 
industrial park lit up in various 
colors.  Many a summer night has 
been spent at Bukbu Beach drink-
ing till the sun comes up. 

Written by Justin “El Sub-Commandante Justino” Sowers
Photos by Nadia Hugo

Bar and Grill’s New Beach Location 
a Hit in Pohang

Tilt’s new location is also situated near several motels that offer rooms for 50,000 won or less per night.  To find 
Tilt, simple hop in a cab and ask the taxi driver to take you to “Bukbu Beach, Valentine Hotel” (북부, 바래틴호
탤).  Valentine Hotel faces the beach, but it is the side of the hotel that is away from the beach that you want to 
go to.  Once you are standing with the hotel between you and the beach, a sign saying Tilt Bar ‘n Grill should be 
visible.

“...greatest thing to 
happen to Pohangers 
since Burger King...”

To find Tilt, hop in a cab and ask the 
taxi driver to take to “Bukbu Beach, 
Valentine Hotel” (북부, 바래틴호탤)

PROVINCIAL REPORT : POHANG PROVINCIAL REPORT : POHANG
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What is this “disc golf ” 
that you speak of?  I’m not 

throwing any of my CDs around, 
am I?  For those of you worried 
about retaining the sound quality 
of your music, I have 2 things to 
say.  First, you are a dinosaur, get 
an mp3 player.  Second, this is golf 
with Frisbees, man!

Disc golf is a sport played with 
specially designed Frisbees/
discs that are smaller than normal 
ultimate discs.  Players throw to a 
pole-hole basket (see photo) while 
avoiding trees, water-hazards and 
sand traps in effort to card the 
lowest score.  Just like in regular 
golf, there are different “clubs” for 
different situations.  A beginning 
player can make due with 2 or 3 
discs, while seasoned players can 
be seen toting bags of multi-
colored saucers and lauding the 
benefits of throwing a Roc instead 
of a Shark.  Dude, why wouldn’t 
you use a Leopard here?  Can 
you really make that shot with a 
putter?

With no permanent courses set 
up in Korea as of yet, disc golf 
enthusiasts are forced to play with 

tem-
porary 
baskets.  
However, 
you have 
the op-
tion of 
creating 
new 
courses 
wherever 
there is 
enough 
room!

Every month, a small but dedi-
cated group of players get together 
in different parts of the country 
to play in rounds of singles and 
doubles.  Doubles are played with 
random partners in a best disc 
format where both players on each 
team decide which of their 2 shots 
they should play from.  This gives 
everyone the chance to play better 
and have as much fun as pos-
sible.  Each player usually ponies 
up 5000 won per round to split 
between the winners.

The monthly tournaments will be 
played in a number of locations 
including Seoul World Cup Park, 

Jeon-ju, 
Jin-gyo 
and Busan.  
Next 
month’s 
tourna-
ment is on 
April 7th 
in Jeon-ju.  
There 
are also 
KPDGA 

(Korean Professional Disc Golf 
Association) sanctioned tourna-
ments.  The first one is in Busan 
on May 28th!  These larger tour-
naments will have actual entrance 
fees, prizes and multiple divisions 
for players of different skill levels.

Full weight golf discs are difficult 
to come by in Korea, but there 
are plenty of places to purchase 
them online.  Shipping is a bit 
expensive, so you might want 
to go in with some friends or 
contact members of the KPDGA 
Facebook group.  Beginner-
friendly discs under 170 grams are 
available for purchase from the 
KPDGA in Seoul and can usually 
be shipped within a few days.

Chaz Burton, the foreign emissary, 
is a great person to get a hold of 
as he is in constant contact with 
the club.  If you are nice to him, he 
might even let you use some of his 
many discs.

Disc Golf in Korea?
Written by Eric Fitzsimons
Special thanks to Chaz Burton and Sung-bae Kim

© Robert Byron | Dreamstime.com

Korean Professional 
Disc Golf Association 
(KPDGA)

DISC GOLF

서래갈매기

여러분이 대구 혹은 대한민국 어느 도시에
든 살아보았다면 바베큐 식당을 잘 알고 있
을 것이다. 아주 간소하고 몇 되지 않는 메
뉴와 내부 장식이 별로 되어 있지 않다는 것
이다. 그렇지만 바비큐식당은 맛있고 또한 
고기가 불 위에서 구워지는 모습을 보는 것
은 항상 즐겁기 때문에 그러한 것들이 별로 
문제가 되지 않는다. 대구시내중심에 있는 
서래갈매기 식당은 실내장식이 예쁘게 되어
있다. 슬라이드 유리문을 밀고 들어가면 식
사하는 곳보다 약간 높여진 복도가 있다. 이 
복도는 자리가 없을 때 기다리는 사람들을 
위해 잘 장식이 되어 있다. 계단을 따라 내

려가면 식당의 중심부가 나오는 데, 여러 명
의 친절한 종업원이 배치되어 있다. 식사준
비를 하는 곳은 커다란 창을 통해 볼 수 있
다. 바닥 재질과 잘 어울리는 나무로 된 탁
자에 앉으면, 아무리 사람이 많아도 좁다는 
느낌이 들지 않는다. 탁자간의 공간이 최대

화하여 낯선 사람들과 함께 식사를 하고 있
다는 느낌은 들지 않는다. 식당의 크기는 크
지 않지만, 넓은 느낌이 든다. 또한 약한 조
명이 편안한 느낌을 준다. 고기를 특별한 
소스에 재서 어느 식당보다도 부드럽고 맛
있다. 서래갈매기 식당은 시내중심뿐 아니
라 대구 경북대, 계명대, 두류, 상인에도 있
다. 시내점은 KUSH와 Who's Bob 사이에 
있다. 서래갈매기의 메뉴는 다른 식당 보
다 조금 다양하다. 가격도 적당한데, 12000
원에서 19000원이면 두 명이 먹을 수 있
다. 맥주는 3천원이며 두명이서 3만원 이하
로 멋진 곳에서 맛있는 음식을 저렴하게 즐
길 수 있다. 
 
밸리 댄스
 
아주 오랜 세월 전에 중동 지역에서 시작된 
밸리 댄스라 하면 전통 중동 음악에 맞추어 
여성이 힙을 움직이는 동작이라고 생각하기 
쉬운데 이번 이번 공연에서는 
새로운 스타일의 음악과 춤이 주요 밸리 댄

스 공연과 함께 만들어졌고 발레, 재즈 동작
들과 혼합되며 당대의 팝 음악인 마이클 잭
슨의 곡과도 어우러진 공연을 펼쳐보였다. 
가장 인상적이였던 공연은 12살 소녀가 다
른 나이 많은 댄서들보다 더 힙을 잘 움직일 
수 있었고, 더 경험많은 댄서가 몸의 다른 
부위들로 정확하게 리듬을 타는 것이였다. 
2시간의 공연동안 많은 댄서들의 컬러풀하
고 아름다운 의상들고 함께 미소 가득히 에
너지 넘치는 댄스들을 선보였고 그들이 진
정 그 공연을 즐기고 있음이 느껴졌다.
최고의 무대와 재미를 선사해준 한국 벨리 
댄스 협회(KBDA)와 서래미 밸리 아트학원
에 감사를 드린다. 

© Granitepeaker | Dreamstime.com

© Mayonaise | Dreamstime.com

Photo by Ivan Broida

Korean summary translated by Jean

Korean summary translated by Jean

KOREAN TRANSLATIONS
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H
ow-to-Daegu is a new series of featured articles.  We will explore 
photography techniques, cooking with local supplies, how to do stuff 
around Daegu like transfer money, dealing  with the ever changing im-
migration laws, getting from point A to point kimchi and much more.  
If you have an urge to inform others on  How-to get stuff done, 
email: info@daegucompass.com.  Thanks for gett’n it done Daegu!  

Jimi Cusick is back.  This time with a new photoshop 
technique to help make those ordinary pictures, ex-
traordinary!  He’ll be highlighting A Charcoal Drawing 
Photo. You can search out his great blog full of fantastic 
photos at “Overexposed.” 

Overexposed
http://jimicusick.wordpress.com/

Jimi Cusick

1.  Open the photo that you want to give a char-
coal drawn look. This technique works well on 
faces with an orange hue to them.

2.  Right click on the thumbnail of your image in 
the bottom right corner of the screen. Select the 
option, Duplicate Layer. In the dialogue box, 
label the new layer and click OK.

3.  Go to the menu and select Filter->Other-
>High Pass. Drag the Radius slider to 5 Pixels 
and press OK.

4.  On the bottom right of your screen, there is 
a Blend Mode scroll down menu that is labeled 
Normal at the moment. Click on the menu and 
select Overlay from the list

5.  Repeat step one by duplicating the original 
picture again and drag the new layer to the top of 
the list on the bottom right of your screen.

6.  Still with the newest layer highlighted, go 
to the menu and select Image->Adjustment-
>Desaturate. The new layer should turn to a 
black and white picture. On the bottom right of 
your screen, change the Blend Mode scroll from 
Normal to Hard Light. Your new layer should 
return to color.

Before After

2

3

Hint: Labeling layers with a title 
that reminds you what Photoshop 
tool or technique was used during 
each step will help organize more 
labor intensive projects.

5

6

HOW-TO-PHOTOSHOP HOW-TO-PHOTOSHOP
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7.  Go to the menu and select Layer->Flatten 
Image. This will blend all three layers into one 
picture.

8.  Duplicate the new layer again. Label and press 
OK. Press CTRL+F to apply the same effect 
that was used earlier in the process. Once again, 
change the Blend Mode scroll down menu from 
Normal to Overlay.

9.  Flatten the image again like in step 7. Go to the 
menu and select Image->Adjustments->Curves. 
Click on the diagonal line and drag it towards the 
top left corner as shown. This will make your im-
age a little lighter. Click Ok.

10.  Click on the new curves layer in the bottom 
right of your screen to highlight it. Press CTRL+I 
to darken picture.

11.  Press D to change your foreground color to 
white.

12.  Go to the menu and select Filters->Sketch-
>Charcoal. Press OK.

Boom! You’re done.

Filters like the Charcoal effect create spectacular images in only a few steps. Try using combinations of different 
filters on your photos to really alter your original pictures and create something unique of your own.

Before After

HOW-TO-PHOTOSHOP HOW-TO-PHOTOSHOP

23



Upon graduating university in 
2009, I searched for ESL jobs in 
South Korea. I was aware of the 
EPIK program and its notable 
reputation, but the recruitment 
periods were only in early Spring 
and mid Summer every year. I 
couldn’t make the Summer ses-
sion deadline due to school, and I 
was too impatient to wait for the 
Spring session. Websites such as 
Dave’s ESL Café (http://www.esl-
cafe.com) have an overabundance 
of job positions listed by dozens 
of recruiters, so frankly, finding 
information is easy. But how 
can you know which recruiting 
companies are legitimate when all 
the postings state the same things 
in large font and symbols?
 
I found a recruiter, who was very 
friendly and walked me through 
the application process. He found 
me a position at a Daegu branch 
of iSponge English Kindergarten 
School, a private franchised insti-
tution for children between the 
ages of 5-8. To me, this was a good 
place to start because I wanted 
to have experience with that age 
group. I was excited to be plagued 
by their cuteness, the cute random 
broken English that would spill 
out of their cute mouths and I 
would be the “fun-waygook-teach-
er” to them. The official contract 
appeared to be structured, stating 
that I had 20 teaching hours, 
health insurance, 3 days of sick 
leave, 2 weeks of holiday vacation, 
and so on. A phone interview was 
scheduled with the then-supervi-
sor. It lasted for about 5 minutes, 
and she had only asked about my 
prior experience with children 
and if I could handle misbehaving 

children and what I would do to 
alleviate the problems.

Back in 2009, the E-2 visa could 
be acquired by Americans with 
a State-wide Criminal Record 
Check (CRC). That and my 
statement intent of graduation 
(I didn’t have a diploma yet) 
needed to be apostilled and 
mailed with my application 
to my director, who then sent 
them to the Daegu Immigration 
Office. The entire visa process, 
from getting fingerprinted to 
getting my passport back with 
the visa sticker took less than a 
month. I was so ready to have the 
unforgettable experience I heard 
most people have while teaching 
in Korea. One mistake though; 
I had no idea of the notorious 
reputation of hagwons before-
hand. There are fair hagwons in 
existence but they seem like an 
endangered species, don’t they?

My hagwon could’ve been worse. 
I was paid on time every month 

and I do have fond memories of 
a few former students and co-
teachers. A few reasons that led to 
my decision to quit mid-contract 
include an incredible lack of 
organization from the director 
and head Korean teacher, I was 
teaching over 35 hours a week 
with virtually no breaks, I was not 
allowed to take any sick days, and 
I disliked the high expectations 
from the wealthy Korean mothers. 
When this happens, there are con-
sequences regarding the E-2 visa. 
A) You go back to your respec-
tive country and cannot return 
to South Korea to teach ESL 
until your current E-2 visa ex-
pires. B) If you quit before your 
6 month mark and find another 
hagwon to work for, there is a lot 
of paperwork involved. Among 
them are a personal statement 
explaining why you want to end 
the contract early, the current 
director’s written consent to let 
you leave, and some documents 
your new director must sign. C) 
If you quit after your 6 month 

Hagwon to EPIK
HAGWON TO EPIK

© Sebastian Czapnik | Dreamstime.com

Written by Stephanie Edlund
Special thanks to Galen Cho and Candace LaCosse
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mark, it’s somewhat simpler. The 
Korean government’s immigra-
tion hotline (1345) is a great 
resource and they can speak 
English very well. Because of 
my Korean heritage, I was able to 
apply for an F-4 visa, so I stayed in 
Korea for a few more months and 
taught some private lessons before 
returning home for the holidays. 

Most of my friends in Korea 
were happily a part of EPIK and 
I decided to apply for the Spring 
2011 semester. Applying to EPIK 
is a more time-consuming and 
demanding process than to a hag-

won, but the acceptance into the 
program is worthwhile in the end. 
A personal essay and 2 letters of 
reference are required. You’re 
able to request what level you 
want to teach (elementary, middle, 
high, international high, adult) 
and the top 5 cities/provinces you 
want to be placed in; however, 
placement is not guaranteed, 
because applications are on a 
“first come, first serve” basis. If 
you’re in a metropolitan city, you’ll 
know that much at the least, but if 
you’re in a province, that’s it, until 
the last day of orientation when 
specific placement information is 

revealed. Depending on if you are 
in Korea or in your native country 
at the time of application, there 
are 2 significant differences. Since 
I was in Korea, I needed a Korean 
Criminal Background check. 
It was a very easy procedure. I 
walked in to a police office, had my 
fingerprints taken, and received 
the clearance paper within an 
hour. Also, my interview with 
an EPIK national coordinator 
was via Skype video, instead of 
a regular phone call. It was 20 
minutes long and the questions 
asked were beyond asking if I can 
handle naughty children. Topics 

brought up included why I want 
to teach ESL in Korea specifi-
cally, where I thought I would be 
in 5 years, and “What Would You 
Do” classroom scenarios.
 
In September 2010, the Korean 
government changed its E-2 visa 
regulations for Americans. The 
State CRC was replaced by the 
Federal Criminal Record Check. 
The process to get that alone 
can take up to 3 months, or so 
the FBI operator told me when 
I called. Mine took 5 weeks to 
receive in the mail, and another 
few days to apostille. Along with 

the original documents and ap-
plication to the EPIK National 
Office in Seoul, 2 copies of every 
sheet needed to be mailed as 
well. Unlike my hagwon that 
immediately purchased my flight 
ticket, EPIK refunded me with a 
1.3 million won airfare allow-
ance around the time of my first 
paycheck. I was surprised that 
EPIK also gave a 300,000 won 
starting allowance during the 
first week of teaching. 

I was amazed how well EPIK 
took care of our group of over 
400 during the 9 day orienta-
tion in Busan. It gave these new 
wander-lusting individuals an 
opportunity to make friends 
and learn about Korean history 
and culture. The cooks of the 
Bukyeong University dormitory 
served many Korean dishes for 
everyone to taste. Honestly, the 
lectures were redundant because 
I was already familiar with Daegu 
and what Korea has to offer, 
and I knew I may or may not 
experience the same things as the 
speakers did. It was best to take 
all the advice with a grain of salt. 
What concerned me most was 
how well I would be able to work 
with a co-teacher. In the past, I 
taught classes of 5-10 students by 
myself. When a problem arose, 
the students needed to tell me 
themselves what the problem was 
and I tried my best to fix it despite 
a language barrier. Being in EPIK 
means there is another instructor 
with his or her own ideas and ide-
ology to consider and incorporate 
in the classroom.

Everyone’s school situation is 
not quite the same. Assigning 2 
EPIK teachers to a public school 
is a recent development and I’m 
fortunate to be the new, second 

Guest English Teacher (GET) at 
my elementary school. I’m able to 
teach to students who never had 
the opportunity to interact with a 
native English speaker in a class-
room, or even in their lives. There 
are tons of lesson plans and games 
on the internet that I couldn’t use 
because my previous hagwon’s 
curriculum was strictly limited to 
textbooks. Our “English Zone” 
is a great room for learning, with 
big whiteboards, Velcro boards, 
a massive flat screen TV, English 
board games and books. EPIK’s 
standards allow a maximum of 22 
teaching hours per week and any 
additional teaching hours count 
as overtime. The English level of 
my 3rd and 5th grade students 
are much lower than my former 
kindergarteners, so it is often dif-
ficult to communicate with them. 
With this said, having a Korean 
co-teacher in the classroom has 
been beneficial. However, having 
a balance of co-teaching respon-
sibilities isn’t always as easy as it 

sounds. I feel that it is a continu-
ous issue between foreigners and 
Korean teachers, but communi-
cation between both groups is 
important in order to make com-
promises and work better together.

Since I’ve been a part of EPIK, 
I’ve come to enjoy the little things 
more; like that I have my own desk 
and computer for lesson planning. 
The sun is still out when I leave 

work. I have the energy to social-
ize after work or to cook a real 
dinner at home. I definitely am 
pleased with where I am, but I’m 
glad to have had experience with 
a different side of teaching ESL in 
Korea. I learned that sometimes 
you have to subject yourself to 
challenging ordeals in order to 
gain perspective and appreciation 
when things are in your favor.

Required Documents Optional Documents
Completed Application Form Copies of Teaching Certificate or Certification

(TEFL (100+ hours), TESOL (100+ hours),
Teacher’s Certificate, Etc)

A Copy of Bachelor’s Diploma with Apostille 
Attached

Proof of Full-Time Teaching Experience

Original Sealed Transcripts Copy of Citizenship and a Copy of Legal Residence 
Certificate (for Korean citizens only)

A National Level Criminal Record Check with 
Apostille Attached (ex. FBI bg check)

Proof of English Education (for Korean citizens 
only)

Two Letters of Recommendation from 
Academic/Professional Sources
Copy of Passport Photo Page

Korean Criminal Record Check (only applicants 
applying from within Korea)

Start your career with EPIK.  http://www.epik.go.kr/

HAGWON TO EPIK HAGWON TO EPIK

© Jonathan Ross | Dreamstime.com

Photo by Candace LaCosse
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Trans-Siberian travel 
report Mongolia : Part 2

Part of the adventure is coming to Korea.  The other part is leaving Korea and 

exploring the many gems Asia has to offer.  To celebrate the beginning of the 

Daegu Compass, Edward Pye reports on his experience aboard the Trans-Siberian 

railroad.  This is the SECOND part of a three part series that will highlight his 

adventures and provides helpful hints if you ever decide to take the journey 

yourself. Спасибо (thank you in Russian) Eddie from the Daegu Compass.

Share your adventures with the Daegu Compass.

Email : info@daegucompass.com

Stamp that!  
 a Traveler’s taleDear reader,

Best, 

The Daegu Compass team

Written and photographed by Edward Pye

There’s a point traveling 
across China, where 
the arching cliff forma-

tions, lush mountain ranges and 
sprawling Shaolin-style lakes 
disappear completely. But rather 
than being distraught at the loss 
of this epic natural beauty, you 
are lulled into a sense of almost 
dream-like surrealism as they are 
replaced by unending waves of 
rolling green hillside. There are 
no trees or bushes – just perfectly 
green carpet-like knolls. These are 
the Steppes and it’s at this point 
that you know you have reached 
Mongolia.

Of course, if you are traveling on 
the Trans-Siberian railway as my 
girlfriend and I have been doing 
for the past two weeks, then there 
is first the matter of bidding fare-
well to China...

After leaving Beijing 2 days earlier, 
we arrive at the ‘middle of no-
where’ border crossing called Er-
lien at 9pm at night. It is supposed 
to be a 2 hour stopover to check 
passports and change the wheels 
on the train (or bogies for the 
horologists out there.) Apparently 
China and Mongolia have 2 dif-
ferent types of train tracks which 
seems odd but it’s not the first or 
last striking contrast between the 
2 countries.

While our train disappears to get 
its make-over we go inside the 
customs office to get our visas 
checked. The office is a stark 

reminder that we are still in 
China with people pushing 
others out of the way to get 
passports stamped or snap 
up the last items of food 
from the sparsely stocked 
snack shop. But going 
outside, you suddenly 
realize that you are heading 
into Mongolia. It grabs you 
with one distinct thing – 
immense silence. The air 
is crisp and sharp and the 
moon  pierces the darkness 
without neon lights to dim 
its glow. It is something you 
can only really experience 
when you are deep into a 
vastly empty country.

6 hours later, our train rolls 
back around with a new set 
of wheels and we are ready 
to travel the extra 12 hours 
to get to Mongolia’s capital 
– Ulaan Baatar.

We arrive the next day 
and again the contrasts are 
evident. Compared to the hustle 
of Beijing, Ulaan Baatar seems to 
be practically standing still. There 
is a dash of modern development 
but generally the city kind of 
resembles a pumped up frontier 
cowboy town weaved in with the 
ruins of a decimated Buddhist 
culture.

Despite the progressive state of 
the city, our hostel, The Golden 
Gobi, is very modern and funky 
and the owners are superb. They 

immediately set us up on an 8 day 
tour which is the only way to see 
the country – Mongolia is over 1 
and a half million square kilome-
ters and there are no roads beyond 
70km of the capital. Unless you’re 
willing to use goats and rocks as 
landmarks for directions, then 
doing a tour without a guide is not 
recommended.

The next morning we are loaded 
into a Russia econo-van (the only 
vehicles that can handle the rough 
terrain) with our guide Khish-
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gee (pronounced Heeshga) her 
brother (the driver) and 4 Swiss 
girls who immediately pronounce 
me the hen amongst the chickens.
At this point we didn’t know about 
Mongolia’s lack of roads, but 2 
hours into the journey it became 
very apparent. At first we thought 
our driver had taken a back-road 
and gotten lost, but we soon real-
ized that everywhere is back-roads. 
In Mongolia you make your own 
road and you might have to drive 
through a herd of goats or horses 
to do it. 

After about 4 hours we reach our 
first base – a Ger camp on the 
fringe of the Gobi desert.  A Ger 
is a large portable tent in which al-
most 40% of Mongolia’s nomadic 
population live in as they travel 
around herding different varieties 
of animals. At the camp, we milk 
some goats and then take an 
uncomfortable and groin crush-
ingly fast camel ride into the Gobi 
desert. Going to sleep on the floor 
of the Ger is bizarrely comforting 
compared to the travel we have 
undertaken today.

As our tour is only 8 days, we are 
on the road again early the next 
day to go to a small settlement to 
watch the Naadam festival which 
celebrates Mongolia’s main sports 
– wrestling, horse-riding, archery 

and sheep ankle-bone flicking. 

The festival is flush with color and 
excitement, children as young as 4 
years old take place in 50km cross 
country horse races; while massive 
Mongolian men push and sweat 
onto each other then do a bird-like 
dance to celebrate their victory. 
Over at the sheep bone flicking, 
old men dressed in their countries 
army uniform position themselves 
to knock over targets and cackle in 
approval when someone knocks 
one down. We eat Khuushuur 
(deep fried meat dumplings) 
and goat cheese and drink Airag 
(fermented mare’s milk) which 
is every bit as disgusting as it 
sounds.

The next few days see us swapping 
our van for sneakers as we hike for 
two days to reach one of Mongo-
lia’s seven famous lakes. Not being 
a huge hiking fan, hiking for 16 
hours is not my favorite part of the 
tour but seeing the countryside 
along the way is rewarding. On 
night 2 of the hike we stay in an-
other Ger where the owners show 
us how to milk Yaks and feed us 
vodka made from that same milk – 
much better than the Airag.

On the final day of the hike we 
learn that we will be horse-riding 
back the last 70 kms. I have never 

ridden a horse before but it must 
be better than hiking. After some 
initial difficulty, due to a stubborn 
horse that liked to chase dogs, I 
get the hang of giving instructions 
and can thoroughly say that one 
of the most thrilling experiences 
of my life was getting that horse 
up to galloping speed across the 
Steppes. If I could offer one piece 
of information though, it would 
be do not wear jeans with a seam 
unless you want rawhide. My girl-
friend would also like to stress the 
importance of a sports bra.

After that, we were back in the van 
for more tourist activities such 
as river-driving, Buddhist temple 
and water-fall visiting, rock-scape 
climbing and natural thermal area 
bathing, but for me Mongolia had 
already sold me on its incredible 
culture. Living in Gers and taking 
just a few days in the life of a 
Mongolian completely blew my 
mind. If I could describe it in one 
way, I would say it is like stepping 
into a time machine and traveling 
back around 130 years to cowboy 
times. It has such a frontier feel to 
it which was fully complete with 
the resourcefulness, adventure  
and open spirit that Mongolians 
must feel all the time.
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Travel Tips 
 
* Make sure you check all the applicable visa requirements – getting into these countries can be a nightmare,  
   so it’s better to be fully prepared and organized. 
* Book ahead for hostels as they are very busy depending on the time of year.
* Take the right clothing. I wouldn’t recommend taking anything you want to keep.
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Baseball season has finally arrived.  
The Samsung Lions take to the field again to follow 
up on their impressive season last year.  Home 
games are always fun and usually packed.  Get their 
early, especially if you have a large group of people. 
Get in the mix and stand behind the Lions dugout.  
No one sits for the whole game.  There are drums, 
beer, chicken, face paint, cheerleaders and oh yeah, 
baseball.  Gooooo Lions! 

Directions in a taxi : “Shi Min oondong jjang ga ju 
say yo.”  (or just say, “Samsung Lions,” and act like 
your swinging a bat.  It’ll work, 100% of the time.

May 2011
Home Game Schedule

5/1 vs 한화 (17:00) Sun

Photos and schedule 
courtesy of Samsung 
Lions.  

5/6 vs LG (18:30) Fri

5/8 vs LG (17:00) Sun

5/11 vs SK (18:30) Wed

5/17 vs 넥센 (18:30) Tues

5/18 vs 넥센 (18:30) Wed

5/20 vs 두산 (18:30) Fri

5/22 vs 두산 (18:30) Sun

5/21 vs 두산 (17:00) Sat

5/27 vs SK (18:30) Fri

5/28 vs SK (17:00) Sat

5/29 vs SK (17:00) Sun

5/19 vs 넥센 (18:30) Thur

5/7 vs LG (17:00) Sat

5/10 vs SK (17:00) Tues

5/12 vs SK (18:30) Thur

SAMSUNG LIONS BASEBALL MAY SCHEDULE
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Daegu Stadium has been recog-
nized to be an attraction for tour-
ists since the Korea-Japan World 
Cup Event. Many people are 
visiting Daegu Stadium for various 
physical and leisure activities as 
well as a scenic driving course 
for the public. Daegu Stadium, 
which receives a lot of 
attention, is prepar-
ing for the The IAAF 
World Championships 
Daegu 2011 with 
upgraded equipment 
and facilities. .

Daegu Stadium is 
the main multi-arena 
for the 2011 IAAF 
World Champion-
ships Daegu and has 
the capacity to hold 
66,000 spectators. 
Daegu Stadium hosted the “2002 
Korea-Japan World Cup” as well as 
the “2003 Summer Universiade.” 
Since then, it has upgraded its 
sound system and restructured its 
facilities to prepare for this event 
for the global stars of track and 
field.   

The JumboTron (main display 
screen) has been replaced with the 
newest model, with the ability to 
split up to 6 different sections on 
the screen. Both the main display 

screen and the sub-screens now 
have 50% larger size viewing 
areas and increased hi-definition 
capability.   
 
The lighting installation has also 
been upgraded with more lighting, 
and the lamps and light bulbs have 

been replaced so the spectators 
can watch the game anytime as if 
they are watching in daylight. The 
TV audiences can also experi-
ence more realistic views of the 
game due to these changes. The 
lighting installation has also been 
upgraded with more lighting, and 
the lamps and light bulbs have 
been replaced so the spectators 
can watch the game anytime as if 
they are watching in daylight. The 
TV audiences can also experience 
more realistic views of the game 

due to these changes. Also, the 
sound system has been dramati-
cally improved by replacing the 
audio mixers and amps, and rein-
forcing the speakers; plus other 
adjustments have been made to 
the point where it would be enjoy-
able to listen to classical music in 

the spectators’ seats. 

A notable change 
which was completed 
last December is 
that the track surface 
which was formally 
covered with polyure-
thane rubber was re-
placed by the “Mondo 
Track” in accordance 
with the “International 
Association of Athlet-
ics Federations” rec-
ommendations. The 

“Mondo Track” has the nickname 
of “The Record Maker” because it 
has the good “rebound resilience” 
suitable for athletes to improve 
their records. Also, its color is 
blue, which is known to increase 
focus for the runners, create a cool 
atmosphere of the stadium, and 
decrease strains on the eyes for the 
TV audiences.  

Also, the warm-up gym and the 
preparatory gym specialized for 
the ‘Throwing Events’ have been 

built in walking distance from the 
main arena. The warm-up gym 
also has a track composed of the 
same material as the main track, 
and there will be a temporary 
electronic display screen to notify 
the game stats, schedules and 
information to the athletes who 
are preparing. The preparatory 
gym (for Throwing Events) will be 
comprised of the areas each spe-
cialized for Shot Put, Discus and 
Javelin Throw as well as changing 
rooms, massage rooms, waiting 
rooms, and other amenities. This 
gym is planned to be completed 
by this July. Of course, the most 
important thing is the amenities 
for the athletes. If these athletes, 
who are visiting from all over the 
world, are able to maintain their 
best condition, it is only then that 
they can strive to achieve better 
performances and break records. 
In order to supply for the shortage 
of room and board, the organiza-
tion committee is constructing a 
state-of-the-art 512 family-capac-
ity Athletes’ Village. The quarters 
are located on the riverside of 금
호강, 7 minutes away from the 
main stadium, and it will provide 
the best accommodations and 
amenities for 3,500 athletes and 
managers visiting Daegu.          

Currently, the Athletes’ Vil-
lage is 99% completed, and the 
organization committee will take 
over the building in May, and 
furnish the rooms with appliances 
and furniture. It is scheduled to 
officially open on August 20th.
The Athletes’ Village includes 

TIC (Technology Information 
Center,) registration office, health 
clinic, and many other convenient 
service areas. Also, each room will 
be equipped with a computer and 
a TV with internet connection 
and other top-of-the-line services 
will be provided. Also, for the 
convenience of the athletes and 

managers visiting Korea, there will 
be a fitness club, postal and bank-
ing services, karaoke and various 
convenience stores and rest areas.
The Athlete’s Village will be avail-
able in the housing market for the 
local citizens after the 2011 IAAF 
World Championships Daegu as 
a valuable reminder of this global 
event.

The organization committee is 
doing their best to raise the status 
of Daegu city in Korea, and they 
are committing themselves from 
the standpoint of the visitors. 
Thus, this August event will be 
undeniably successful. In order 
to continue public interest for 
track and field sport seven after 
the 2011 IAAF World Champi-
onships Daegu, the 육상진흥센터 
( Jin-Heung Track & Field Center) 
is being constructed on the west 
side of Daegu Stadium. 육상진흥

센터 is built in the scale of 21,577 
square meters with 4 floors above 
ground which will include an 
indoor track & field arena, a track 
& field academy, and other aux-
iliary facilities. The indoor track 
& field stadium will have 6 lanes 
of 200m and 60m tracks, Long & 
High Jump and Pole Vault as well 
as Shot Put equipment, and it will 
have the capacity for 5,000 specta-
tors. The Track & Field Academy 
will have 50 athlete dormitory 
rooms (able to house 100 people) 
and 5 lecture halls. Other facilities 
include a training gym, sports/
science center, media rooms, 
etc. Actually, the 육상진흥센터 is 
considering the possibility for a 
transition from the 2011 IAAF 
World Championships to organiz-
ing and developing the “World 
Indoor Track & Field Games,” a 
continuous event which would be 
hosted in Daegu. Other than this, 
this center is planned to be used 
as a multicultural venue hosting 
various track & field champion-
ships, basketball games, and other 
cultural and artistic events.

Press release and photos courtesy of the IAAF World 
Championship Daegu committee  
Press release translated by Baek San

2011 Daegu Stadium: a sensational stage 
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Why did you choose the handle 4Play? 
A close friend of mine helped me select the name. Seeing that at the time I was more of a warm up DJ, 4play 
seemed appropriate.  It was my role to get the crowds in the mood. Being a warm up DJ really prepared and 
taught me how to read a crowd. You wanna keep the room on their feet, surprise them, keep it interesting.  I still 
abide by that philosophy.  

What changes have you witnessed since arriving in Korea? 
I arrived in Korea in 2002.  Then, Hongdae was the place to go. Club Night was in its infancy.  Two clubs that 
really stood out were Matmata and Myungwolgwon. These very intimate venues were the kind of places you 
could approach anyone, dance anywhere, and do anything. There was a real community feeling back then.  Seoul 
only received an international act once or twice a month.  These were events! Then the era of the super club 
arrived and international acts became the rule not the exception. Presently we are witnessing a renaissance in 
Itaewon with clubs such as B1, Function, LUV, and Venue. After-hours seems to be the trend now so it should be 
interesting to see what happens in the future.    

How would you define your sound?
A groovy funky blend of Big Room, Tech and Electro House is what I spin. I think if you listen carefully to my 
sets you are bound to find some disco elements and old school samples also.  

What is a track that always works for you? 
 Sorry, I can’t tell you that. It’s a secret.

Who is your favorite DJ/Producer?
At the moment it’s a toss between two different producers. Recently, I have really been enjoying the production 
of Gramophonedzie.  His productions have an air of nostalgia, cheekiness and history to them.  He incorporates 
a variety of genres and old samples and fuses it into a tasty concoction. The other many will recognize in some of 
my sets is Joey Youngman aka Wolfgang Gartner.  He has really been one my favorite producers over the years.  
His sound epitomizes what Electro House should be.  He has very distinct , phat, charging bass lines that force 
you to bounce uncontrollably . 

What is the most hilarious thing you have seen behind the decks? 
While playing at the Boryoung Mud Festival there were torrential rains and a high tide. Eight people were hold-
ing down the tent to stop the water from getting as thousands danced amidst it all. In retrospect, I realized that I 
almost got electrocuted playing electro.  

Do you think technology has helped or hindered your performances? 
I am really not ready to make the switch to digital DJing. I still enjoy looking in my CD book for a track. I think 
nothing is more boring than watching a DJ stare into his laptop, playing with his mouse and clicking the sync 
button.  Recently there has been some headway in digital interfaces, but I am not sold yet.  I am sure in the future 
I will make the switch as the technology evolves and find a system that suits my style. 

What advice do you have for aspiring DJs?  
First, take every opportunity to play with DJs from various genres or those who have more experience.  They 
will push you, challenge you, criticize you, but in the end, it will only make you a better.  Second, Every DJ must 
consider three things: The Crowd, The Club Management, and Yourself. Hopefully, all three are happy.  Finally, 
scope the entire club and see what the people there are doing.  Are they dancing, lounging or leaving?  Focus on 
the club not the crowd in front of you. 

What can we expect from DJ 4Play in the future?
Find me at B1 or my other residency at Club Ellui. You can also tune in to “In da Club” every Friday from 9:00- 
10:00 PM on TBS eFM 101.3. That is the future for now.

“An audiophile who plays the crowd like no 
other and his pool sets have become legendary.” 

We wrote these words about Matthew Clement some time ago and 
he continues to exceed our expectations. Clement aka DJ 4Play has 
been an integral part of the scene for years. 4play enhances and stimu-
lates any club he enters and his positive outlook and vibe whether he is 
supporting a night or headlining one is a lesson for us all. 

Written by SeoulVibes
Photos courtesy of SeoulVibes
Special thanks to Groove Korea

Contact Urban Events for all your electronic 
music needs. : seoulvibes@gmail.com  www.myspace.com/seoulvibes

www.soundcloud.com/seoulvibes

www.samurai.fm/seoulvibes

SEOULVIBES MUSIC REVIEW SEOULVIBES MUSIC REVIEW
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You probably aren’t as passive 
aggressive as the Dude’s bowl-
ing partner, Walter Sobcheck 
(played by John Goodman) in the 
Coen brother’s cult class, “The 
Big Lebowski.” But you probably 
have experienced the cathartic 
and high energy release of hitting 
the pocket and striking down all 
ten pins in a bowling alley. There 
is something addictive about it, 
something kinetic.. as I’m sure 
any league bowler will tell you, 
especially those rolling mixers in 
the Daegu bowling league at the 
moment.

Bowling is a popular past time 
in Korea and with Korean lanes 
around a quarter of the price of 
western lanes (and numerous in 
Daegu) there has always been a 

big demand for league action.

The previous Daegu league ran 
for four seasons up until 2006 
and threw up many quality teams 
such as “Scars and Stripes” and the 
“Turbo Stallions” all competing 
for the coveted Daegu head-
pin and personal high scores. 

However, with the often changing 
nature of personnel in Korea the 
league ground to a halt;  and so it 
was for several years...

But in 2011, the league has made 
a long awaited return with new 
teams, new players and an exciting 
new format. It has moved from 
Seongseo to Siji but the enthusi-
asm from all areas of Daegu has 
stayed strong. 

Now into its 6th week of 10, the 

league involves 4 teams of 4 bat-
tling it out against each other in 
an ‘all-on-all’ format. To counter 
different levels of bowling ability, 
the league also has a tier system 

where bowlers ranked into differ-
ent levels also bowl against each 
other, so you can win with your 
team, but also as an individual 
against others of similar ability. 
This has added another interesting 
dynamic to each week’s bowling 
with the tier competitions being 
very closely contested.

With the successful return of the 
Daegu bowling league, there will 
undoubtedly be interest in future 
leagues with more teams and more 
fun. The teams are closed for this 
league but casual bowlers are free 
to come along to the Siji bowling 
lanes and watch or bowl a ball or 
two. For more information get 
onto facebook and search “Daegu 
bowling league” but be warned – 
bowling can be addictive – just ask 
the Dude or Walter Sobcheck.

 “F%^& it Dude, let’s go bowling...” 
Walter Sobcheck, The Big Lebowski.

DAEGU BOWLING LEAGUE DAEGU BOWLING LEAGUE 

DAEGU BOWLING LEAGUE   
                  NEW MEMBERS WELCOME

Daegu bowling league

Written and photographed by Edward Pye

© Mircea Bezergheanu | Dreamstime.com
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SUN MON TUE WED THU FRI SAT

May 2011 
6 7

8 9 10 11 12 13 14

15 16 17 18 19 20 21

22 23 24 25 26 27 28

29 30 31

Oriental medicine culture festival 
@ Yangnyeongsi in Daegu

National Geographic
Exhibit ends May 29 @ Daegu Museum

Yeong Ju 
So Baek San 
(mountain) 
festival @
Yeong Ju 

Dongseongno Festival @ 
Downtown Daegu

Whale watch-
ing in Ulsan

Daegu Theatre Troupe 
Presents: A Spring Fling 24hr The-
atre Challenge @ Buy the book cafe

Comic Martial Arts Performance 
JUMP @ Daegu Opera House

World DJ 
Festival @
Yangpyeong

Paul Potts’ & 
Kevin Kern in 
Korea Tour
@ Keimyung 
Art Center

MADNESS 2011

SEARCH : DAEGU MUDFEST MADNESS 2011   DAEGU EVENTS & TOURS

Hanaro Tour Company and the Daegu Compass present

email : events@daegucompass.com to sign up

2 great pensions
1 night 2 days : close to the action
picnic tables & grills availabe : we’ll provide the fuel
free mudfest special brew & food to get the party started
a legendary house party  w/live djs

DAEGU 

MUDFEST 

jULY 16-17 OPENING DAY
EARLY BIRD

SIGN UP 
DISCOUNT!

DSF and Scav-
enger Hunt

EVENT CALENDAR

Mischa 
Maisky 
Family Con-
cert (cello) 
@ Suseong 
Artpia

Tuesday 
Morning 
Concert 
(Seoul 
solist cello 
ensemble) 
@ Suseong 
Artpia

Maroon 5 @ Olympic Stadium 
in Seoul / KBS Hall in Busan

Yuri Bashmet 
Moscow 
Soloists En-
semble (Viola 
Virtuoso) @ 
Suseong 
Artpia

Daegu 
Multicultral 
Festival
@ Gukchae 
Bosang park 

This is an overview of our May events.  For more information 
on events in our calendar, check out the next two pages or  
email : events@thedaegucompass.com. Please email us your 
event information by May 15th for our June 2011 issue.  

All photos courtesy of Shawn Perez : check out more great photos @ http://www.flickr.com/stinkiepinkie_infinity/ : full feature coming soon!

Yeong Ju 
So Baek San 
(mountain) 
festival @
Yeong Ju 

Whale watch-
ing in Ulsan

하나로투어 법인등록번호 : 504-81-69311
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May 1 - 16Event Calendar May 17 - 31 Event Calendar

5.3~5.7 
Oriental 
medicine 
culture 
festival

5.1~5.29
National 
Geographic
Exhibit

5.5~5.7 
Comic Martial 
Arts Perfor-
mance JUMP

5.12
Mischa 
Maisky 
Family 
Concert

5.14
Paul Potts’ & 
Kevin Kern in 
Korea Tour

5.17
Tuesday 
Morning Con-
cert (Seoul 
soloist cello 
ensemble)

5.20~5.21
The Daegu 
Theatre Troupe 
Presents:
A Spring Fling 
24 Hour Theatre 
Challange

5.27
Yuri Bashmet 
Moscow Soloists 
Ensemble (Viola 
Virtuoso)

5.20~5.22
Daegu 
Downtown’s 
Dongseongno 
Festival

5.22
Daegu 
Multicultural 
Festival

Tue-Sat

Wed-Thu

Thu-Sun

Thu

Time: 11:00am
Ticket price: R 20,000w 
Place: Suseong Artpia
Ticket information: 
053-668-1800 
http://www.ssartpia.or.kr/

Time: 9pm (Show)
Ticket price: R 5,000w 
Place: Buy the book cafe
Ticket information: 
daegutheatre@gmail.com

Sat

Tue

Fri-Sat

Fri-Sun

Sun

Fri

Daegu’s biggest down-
town festival.  A free 
festival with bands, events 
and scavenger hunt. Sign 
up for the scavenger hunt 
on Sunday to win prizes: 
events@daegucompass.com

Experience Daegu’s Mul-
ticultural “Together day” 
festival.  Lots of activities 
and programs about mul-
ticutural living in Daegu.  
It’s a FREE festival of 
course, so its worth it.
events@daegucompass.com

Time: 7:30pm
Ticket price: VIP 70,000w 
/R 50,000w/S 30,000w 
Place: Suseong Artpia
Ticket information: 
053-668-1800 
http://www.ssartpia.or.kr/

Time: 9:00am-5:00pm
Ticket price: 10,000w
Place: Daegu National 
Museum
Ticket information: 
053-768-6051

Time: 9:00am-5:00pm
Ticket price: Free
Place: Entire area of 
Yangnyeongsi 
Ticket information: 
053-253-4729
https://utour.daegu.go.kr

Time: Thu & Sat 3:00pm, 
7:00pm / Fri 7:30pm
Ticket price: VIP 70,000w / R 
60,000w / S 50,000w
/ A 40,000w / B 30,000w
Place: Daegu Opera House
Ticket information: 
1566-1360
http://daeguoperahouse.org

Time: 7:30pm
Ticket price: 10,000w
Place: Suseong Artpia
Ticket information: 
053-668-1800 
http://www.ssartpia.or.kr/

Time: 3:00pm, 7:30pm
Ticket price: VIP 132,000w 
/ R 110,000w / S 99,000w / A 
88,000w / B 66,000w 
Place: Keimyung Art Center
Ticket information: 
1566-9621
http://kmuartcenter.kr

EVENT CALENDAR EVENT CALENDAR

© Lcc54613 | Dreamstime.com
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Downtown

Suseong-gu, Kyungpook Uni. Area, Sang-in, 
Keimyeong, Siji, Jisan and more areas coming 
soon~
Email us your favorite restaurants and we’ll add them to the guide : info@daegucompass.com

Compass Connoisseur
a guide to the best bars & restaurants around town

Compass Connoisseur
a guide to the best bars & restaurants around town

The Daegu Compass hopes to help you with your 
dining choices.  Daegu is a big city with many hidden 
gems tucked away in the different Gu’s of Daegu.  
These are just a few of the Compass Connoisseur’s fa-
vorite restaurants to eat at.  If you found a golden nug-
get and would like to share it with everyone in Daegu, 
let us know.  We will be expanding in our June issue.  
Please email us at: info@daegucompass.com.  
We hope to hear from you!

The Holy Grill & The Holy Grill Sports Lounge
Daegu is far from Mexico.  Good thing the Holy Grill is here.  The 
best place to get tex-mex in Daegu.  Call to make reservations, 
the Grill gets packed on the weekends. Check out the Compass 
map on page 32 for directions.  It’s near Samduk So Bang Seo.  
Boss level - Holy Grill just opened up a new take-out burger and 
sandwich shop in Sang-in.  Call for delivery!

Business Hours:
2F Restaurant - (breakfast served all day Sat. & Sun.)
Tues to Fri - 4pm to 11pm : Sat - 2pm to 11pm : Sun - 2pm to 10pm
3F Sports Lounge
Fri - 7pm to 2am : Sat - 4pm to 2am : Sun -11am -11pm
Contact:
Downtown - 053.423.4048 or 
Sang-in - 053.633.6665           

SeoraeGalmaegi - http://www.seoraester.co.kr
A new Korean BBQ dining experience.  Located conveniently be-
tween Thursday Party and KUSH bar.  A great way to start out the 
evening.  Great service, fresh interior and excellent food make 
this a Compass Connoisseur favorite!  Check out the Compass 
map on page 32 for directions.

Business Hours:
1F Restaurant 
Everyday 4pm - 4am
Contact:
Downtown - 053.255.8970            

Traveler’s Bar & Grill - http://www.travelersbar.com
Voted #1 best burgers by 10magazine.  Sporting the monster JC 

burger, I know one guy who finished it, Jeff B : rockstar!  A fabulous 
interior, friendly wait staff and great beer selection by BIG ROCK.  

This place gets rocked on the weekend, so get there early. 
Check out the Compass map on page 32 for directions.    

Business Hours:
4F Restaurant - (breakfast served everyday)

Weekdays - 5pm - CL : Weekends - 12pm - CL (food stops @12am)
Contact:

Downtown - 010.4591.4869 or       Traveler’s Bar & Grill

The Holy Grill & The Holy Grill Sports Lounge

Downtown

Western

Western

Korean BBQ

Greeks Kebab and Tacos 
Looking for that late night snack?  Come to Greeks.  

Greeks makes all its ingredients from scratch.  Homemade hum-
mus, BBQ sauce, hot sauce and tazaki sauce help make this take-

out style restaurant a must go to on the weekend.  Friendly staff, 
most of the time, Greeks willl satisfy your late night hunger. 

Check out the Compass map on page 32 for directions.

Business Hours:
1F Restaurant 

Fri & Sat only : 5pm-4am
Contact:

Take-out

Email us your favorite restaurants and we’ll add them to the guide : info@daegucompass.com

RESTAURANT GUIDE RESTAURANT GUIDE

Photo courtesy of Holy Grill

Photo courtesy of Holy Grill

Photo courtesy of Traveler’s Bar and Grill
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Downtown - 053.255.4733    or          Greeks Korea : Kebab and Drinks

51 52



HOTEL GUIDE

Novotel Daegu City Center
Add : 대구광역시 중구 문화동 11-1번지

Tel : 053-664-1115
Website : http://www.novoteldaegu.com
Email : rsvn@novoteldaegu.com

Daegu Grand Hotel 
Add : 대구광역시 수성구 범어1동 563-1번지

Tel : 053-742-0001
Website : http://www.taegugrand.co.kr
Email : concierge@daegugrand.co.kr

Hotel Inter-burgo
Add : 대구 수성구 만촌동 300번지

Tel : 053-6027-171, 173
Website : http://hotel.inter-burgo.com
Email : feel20c@inter-burgo.com

Hotel New Young Nam 
Add : 대구광역시 수성구 두산동 888-2번지

Tel : 053-752-1001
Website : no
Email : nynhotel@nynhotel.com

Hotel Ariana
Add : 대구광역시 수성구 두산동 200-1번지

Tel : 053-765-7776
Website : http://www.ariana.co.kr
Email : arianahotel@nate.com

Welcome to the Daegu Compass hotel information guide.  We will also be adding a 
guide about motels soon.  Daegu is very spread out, and not all the hotels will be con-
venient for you.  We hope our hotel guide will help you with making your decision on 
where to rest your weary bones for the night.  Map will be ready for our June issue.

Downtown Area Hotels

HOTEL GUIDE

Eldis Regent Hotel
Add : 대구광역시 중구 동산동 360번지

Tel : 053-253-7711
Website : http://www.eldishotel.com/
Email : eldishotel@hanmail.net

Hotel the Palace
Add : 대구광역시 남구 봉덕3동 688-1번지

Tel : 053-471-9911
Website : http://www.hotelthepalace.co.kr/
Email : no - online reservation system

Prince Hotel 
Add : 대구광역시 남구 대명2동 1824-2번지

Tel : 053-628-1001
Website : http://www.princehotel.co.kr/
Email : prince@princehotel.co.kr

Nam Gu Area Hotels

Suseong Gu Area Hotels

Dong Gu Area Hotels

Hotel J’s
Add : 대구광역시 동구 신천4동 326-1번지

Tel : 053-756-6601~10
Website : http://hotel-js.com/
Email : http://hotel-js.com/

Near Camp Walker

10 min from Dongdaegu station

Near the nightlife

Across from Dongdaegu station
Close to Express Bus Station

Room rates start at
150,000won

Fantastic all you can 
eat buffet!

Room rates start at
100,000won

Close to Hyundai 
and Dongha Shopping

Room rates start at
99,000won

Near Camp Walker
Clean and Friendly

Room rates start at
105,000won

Western and Korean
rooms available

Room rates start at
240,000won

One of the top 
hotels in Daegu

Room rates start at
330,000won

Daegu Casino 
just opened

Room rates start at
110,000won
Coming again soon,
Ariana Brau (buffet and 
micro-brewery)

Room rates start at
160,000won

Walking distance to 
KTX & Express Bus

Currently under 
renovation 
but placed here for
their great
2FL MICRO-BREWERY

HOTEL GUIDE HOTEL GUIDE
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Big Stage

I can’t help but to be fascinated 
and enamored with Buddhism. 
The array of colors in the 

temples, the smells, the sounds, and 
the utter devotion of her followers 
have all called for me to stop, listen, 
smell, and ask what it is that has 
made Buddhism what it is for so 
many centuries. 

Being from the west, and a former 
Christian preacher, I didn’t take 
much time to examine Buddhism. 
Buddhism was considered a false 
religion for which there was no 
hope for escape from Hell. To even 
be interested in it was considered 
heresy. So, it wasn’t until I got to 
Korea and traveled to Donghwasa 

that I even became fa-
miliar with the beauty 
of Buddhism. 

With just a little more 
than an interest, I 
ventured to a temple 
in KyeRyong with 
a small group from 
Daegu for a one night 
temple stay. One night 
is hardly enough time 
to discover much, but 
it was quite ‘enlighten-
ing,’ if you will. So, for 
those of you (includ-
ing myself) from the 
West, who might not 
have gotten too much 
of an introduction to 
Buddhism, let me say 
a few words. But, I’ll 
be the first to admit 
that I’m probably the 
least qualified of all 
to speak of this great 
tradition.

“The World’s Religions,” written by 
Huston Smith, a classic introduc-
tion to religions states, “Buddhism 
begins with a man.” Not someone 
who claimed to be God, or neces-
sarily proclaimed supernatural 
powers to himself; but simply a 
man who claimed to be awake. Both 
Jesus and the Buddha had people 
asking them not who, but what they 
were. Of the Buddha they asked if 
he was a god, an angel, or a saint, 
all to which he simply replied, “No. 
I am awake.” Thus, Buddha simply 
means the “Enlightened One” or 
“Awakened One.”
Siddhartha Gautama was born 
around B.C. 563 in what is now 

Nepal. Born to a king, his child-
hood was quite luxurious and he 
had most anything a person could 
“dream” of. Though he had great 
wealth, looks, and a magnetic per-
sonality, he became disenchanted 
with material things. He slipped 
off into the forest, shaved his head, 
and searched for enlightenment. 
He emerged six years later, not to 
commence a new religion, but to 
introduce a philosophy, a way of 
living that would awaken an indi-
vidual from the trance of life, and 
bring that one to the same state of 
enlightenment he had realized. And, 
that, he did. 

Buddhism falls under the tradition-
al definition of religion. Its followers 
are committed and devoted to a par-
ticular “faith” and observance and it 
has become an institutionalized sys-
tem. But, when one looks closely, 
they’ll find that Buddhism is more 
of a philosophy than a religion. Reli-
gions are often evangelical to some 
degree, telling you why you must be 
a part of them, or how you will suf-
fer great eternal consequences. Bud-
dhism doesn’t attempt to convert or 
evangelize anyone into the practice. 
They merely say that if one wants to 
awaken to a higher consciousness 
and understand things that are of 
a higher significance, this is a way. 
Not THE way, but A way.

Time and space deter me from 
being able to discuss further Bud-
dhism’s Four Noble Truths, and 
the Eightfold Path. But, certainly 
a philosophy that has existed for 
literally over two and a half millen-
nia, and has born millions upon 
millions of dedicatees, merits some 

respect and consideration, whether 
you are steeped in another religious 
tradition, or have no religions tradi-
tion at all.  

This article comes at the time of 
a great celebration in East Asia: 
Buddha’s birthday. In Korea, this 
day is called 석가탄신일 (Seokga 
tansinil), meaning “the day of Bud-
dha’s birthday or 부처님 오신 날 
(Bucheonim o sin nal), meaning 
“the day when Buddha arrived.” 
The roads will be lined with Lotus 
lanterns and temples will be flooded 
with both Buddhists and non-Bud-
dhists alike. 

My encouragement is to visit the 
temples (most will even offer a free 
lunch!) without fear or hesitation. 
Last year, I visited a few temples on 
this day. The children were laughing 
and playing and their parents were 

calm and 
relaxed. They 
were making 
candles, lo-
tus lanterns, 
and giving 
out rice cake. 
The monks 
are beautiful, 
wonderful 
people, not 
looking to 
convert, but 
simply to 
love and to 
awaken, as 
Buddhists 
are more concerned with inner 
reflection, creating personal peace, 
and thus ultimately emitting peace 
throughout the world. 

This year, Buddha’s birthday will 
be celebrated Tuesday, May 10. It’s 

a national holiday, so everybody 
should have the day off. You don’t 
have to be Buddhist to celebrate the 
Buddha’s birthday. Events and fes-
tivals will be held all around Daegu 
and Korea as a whole. Take time.

Siddhartha Gautama aka. THE BUDDHA

BUDDHA’S BIRTHDAY CELEBRATION BUDDHA’S BIRTHDAY CELEBRATION

Written by Eric Gayle
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DAEGU COMPASS EVENT REVIEWS DAEGU COMPASS EVENT REVIEWS

The belly dance, which started 
many years ago and has its roots in 
the Middle East, has found its way 
to Daegu and Korea thanks to the 
Korea Belly Dance Association 
(KBDA). 

In an event held at the Dongu 
Culture Center on April 10th the 
KBDA in Daegu showcased the 
best and brightest of the belly 
dancers based in this city.
When we think of belly danc-
ing we tend to associate it with 
a woman moving her hips to a 
traditional Middle Eastern song. 
This event did away with conven-
tions and mixed many different 
sorts of styles of song and dance, 
while still maintaining the essence 
of belly dancing. Some of those 
crossovers included ballet, jazz, 
and even contemporary pop with 
the Michael Jackson song 'Mon-

ster' finding its way into one of the 
routines.

There were two memorable per-
formances that night: one by a 12 
year-old girl that could move her 
hips better than most of the older 
dancers, and another by a more 
experienced dancer that followed 
the rhythm with different parts of 
her body with surgical precision. 
Every dance involved a change 
of costume which, for a two 
hour show and the many dancers 
involved, was an impressive feat. 
The dresses were amazingly color-
ful and complex which made the 
dances more interesting and fun 
to watch. One of such costumes 
resembled a giant butterfly with 
wings made of what appeared to 
be gold lamé. 

If anything could have been 

improved it definitely would have 
been the editing of the perfor-
mances. It would have been much 
better to have had a solid one 
hour show than a two hour one 
peppered with somewhat weak 
routines. However, all the dances 
were done with a high level of 
energy and the women smiled all 
throughout the show. It definitely 
felt like all the dancers were having 
fun during the event. The little 
girl sitting next to me certainly 
appreciated this and showed it by 
clapping and dancing in her seat 
for most of the night.

So, if you would like to learn how 
to move your hips like the dancers 
in this show, you can contact the 
Seolaimi Belly Art Academy by 
calling 053.741.1746 or by email 
at seolaimi2000@hanmail.net.

Written and photographed by Ivan Broida

Belly 
Dancing 
with KBDA

Cheong-do Bullfighting 
My friend upon hearing my excite-
ment at going to the Cheongdo 
Bull Fighting, reliably informed 
me that I was going to have the 
most boring time. We are now 
renegotiating the terms of our 
friendship. It was exciting. Daegu 
Compass and Hanaro Tour run 
regular trips to sites of interest all 
around the greater Daegu area and 
beyond. My Korean geography is a 
little sketchy, so unless I make it to 

Seoul or Busan, I feel like I'm still 
technically in Daegu.

The tour had a loose schedule 
that took us first of all to a winery 
that made of all things, persim-
mon wine. Opened in 2006 the 
wine finishes its fermentation 
process in a reconditioned train 
tunnel. Originally built in 1898, 
the tunnel now provides perfect 
conditions for making wine. Keep-

Written by Mark Sands and photographed by Jimi Cusick

ing a moist 70-75% humidity and 
a cool 13-15 degrees centigrade all 
year round, the tunnel is perfect for 
making the nectar of the gods.

Descending upon the romantic 
and eerily beautiful setting 80 
foreigners generally ran amuck. 
The tunnel situated at --경북 청도
군 화양읍 송금리 252-2 provides 
for a modest 3000won, a delightful 
tasting session that offers you a 
generous drop of their best wine, 
a dry white that holds hints of 
sunlight on the tongue. Informa-
tion can be found at their website, 
which is unfortunately only in 
Korean http://www.gamwine.
com/ http://www.청도소싸움.kr/ 
A short drive from Daegu, it really 
is a trip that should not be missed 
out on. Coupled with bullfighting, 
it really is a superb day out.
The Bull Fighting took place 
at Cheongdo stadium, a venue 

perfect for the crash of mammoth 
sized beasts. The open bottle policy 
that is prevalent throughout Korea 
meant that you could even bring 
your own alcohol. The stadium 
was awash with dignitaries more 
than willing to shake a friendly, if 
inebriated hand. Lee Jung Guen 
the local governor was particularly 
fun and has my vote and com-
plete confidence, not that I know 
anything about him. Nor, and I'm 
pretty confident about this, am I 
entitled to vote.

The bullfighting, though slow 
paced, was impressive; especially 
after we saw one of the owners 
take an accidental strike from his 
prized beast. Sending him to the 
ground in a heap, where he lay for 
quite some time. The friendly bets 
being handed back and forwards 
across the top tier of the stadium 
provided punters with plenty of ac-

tion, it is a recommended must to 
keep the uninformed excited.

What really made the day was the 
festive air around the outside of the 
stadium. Korea, generally full of 
surprises for the average foreigner, 
was providing fully cut diamonds 
at the festival and even robotic 
bullfighting.

The day out was truly an adven-
ture, with groups of happy people 
dotted around the stadium enjoy-
ing the last of the spring sunshine. 
Two distinct bus groups provided 
either a haven for sleep or a game 
ending party on the way home. 
The after party finished off most 
at the very smooth JEEEP bar. 
Arranged by Hami, the party like 
the wine tunnel was under perfect 
conditions. 

한국어 요약문 페이지 19쪽에
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JAZZ DANCE

Dong-A department store

KFC

KB bank

Woori bank

SK gas station

Eden town

Pies, Cookies, Cakes, Cupcakes and Coffee

Baked Fresh Everyday

053.782.2034
30, Beomuldong Suseongu

kmh0182@naver.com

JAZZ DANCE

Make new friends, 
check. Exercise, check. 
Learn a new skill, check. 
Have fun, check.  

Well, if you like to do any of the 
above, 
you’ll 
definitely 
enjoy 
JAZZ 
dance.  
Jazz 
dance 
is a new 
fad to hit 
Korea.  
A great 
way to 
exercise 
and stay 
fit. Jazz 
dance 
isn’t just a 
hobby for many people nowadays.  
Jazz dance not only improves your 
health, it improves the quality of 
your life.  

Exercising helps release the stress 
we experience everyday as we 
trudge through our daily routines.  
I felt I needed a new path to 
follow.  After talking with some 
friends about what to do other 
than drinking, they suggested I 
try jazz dance.  Jazz dance?  Yup, 
jazz dance.  So, I decided to visit 
TOZ Dance Academy, located in 
downtown Daegu, just above your 
favorite bar and grill, Travler’s.  

The moment I stepped inside, I 
felt a rush of life course through 
my veins as I felt the energy within 
the academy.  Everyone I met was 
super friendly.  They greeted me 
with open arms and encouraged 

me to loosen up.  I was stiff at first; 
let me tell yeah, I was not in the 
best shape of my life.  But through 
simple instructions and a great 
class, I was able to catch up.  

Everyone in the class comes 
from a different background, but 
everyone seems to have one thing 
in common - enthusiasm for jazz 
dance.  They come to escape the 
rigors life has thrown at them.  It’s 
not just a hobby but an invest-
ment. I feel that I have come to the 
right place. 

The class is 40 minutes of stretch-

ing and 40 minutes of choreogra-
phy.  I usually stretch for like 10 
minutes before I go running, but 
that’s usually because I lose track 
of time.  But to stretch for 40 pain-
ful minutes is a completely new 
experience for me.  Leg stretches, 

arm 
stretches, 
hip stretch-
es, wrist 
and ankle 
stretches, 
butt 
stretches, 
toe 
stretches 
and back 
stretches 
ruin me 
during this 
time.  I 
only hope 
that class 
is almost 

over.  But, I look up and it hasn’t 
even been 10 minutes.  What did 
I get myself into?  This question 
seems to pop up in my head over 
and over.  Finally… we are done 
stretching.  Now, comes the chore-
ography.  This part is worth the 40 
minutes of stretching. I’d give the 
elastic man of the Fantastic Four 
a run for his money. I feel like a 
completely new man twirling and 
jigging about.  Group choreogra-
phy, pair choreography, we cover it 
all. I look around and wonder, why 
haven’t I tried this before?  Jazz 
dance, whoo, is my new inspira-
tion.

The price is just right as well.  If 
you take two classes, you even get 
a discount.  It’s like putting your 
tooth under your pillow when you 
were younger for the tooth fairy 
and in the morning it has magi-
cally transformed into money.  
Yeah, jazz dance is that cool.  
The class I take is held Monday, 

Wednesday and Friday.  It starts 
at 7 pm.  The groovy part of the 
class is Friday when they video 
tape you dancing what you’ve 
learned during the week.  This is 
A-M-A-Z-I-N-G!  They upload the 
video to the homepage where you 
can watch yourself dance, along 
with everyone else in the world.  

Hollywood, here I come!

The director of the jazz class is 
fabulous.  She is very famous for 
being a professional dancer in the 
past. She is very considerate to 
beginners.  Her skills are the skills 
I hope to have by the time I finish 
my jazz class.  

To find out more about TOZ 
Dance Academy, get a Korean 
friend to help you look it up on 
NAVER.  Search: TOZ Dance 
Academy and you’ll find the 
homepage where you can watch 
me shake my money maker.  Oh, 
did I mention that dancing is a 
great way to lose weight and get 
ready for the summer.  Yeah, jazz 
dance, an experience you won’t 
forget!

Get your JAZZ 
on!

Written and photographed by Rui Dong-jung Lee
Revised by Scott McLaughlin
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Compass Sponsors
THANK YOU SPONSORS & READERS

The Daegu Compass would like to dedicate this page to all of our SPONSORS who 
make this information guide possible.  Without your support now and in the future, we 
couldn’t make the Daegu Compass.  We’d also like to thank everyone in the com-
munity who takes time out of their day to enjoy the Daegu Compass.  Our goal is to 
constantly improve to help your stay in Daegu be the best time of your life.  Please visit 
our SPONSORS to show them appreciation for supporitng the Daegu Compass.

Sincerely, 

The Daegu Compass Team

Dong-A department store

KFC

KB bank

Woori bank

SK gas station

Eden town

Pies, Cookies, Cakes, Cupcakes and Coffee

Baked Fresh Everyday

053.782.2034
30, Beomuldong Suseongu

kmh0182@naver.com

for sponsorship rates
contact: sales@daegucompass.com
tel: 010.3815.8169 (Ha Mi-yong) 
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